
© 2006 ... Acclima, Inc.   All Rights Reserved

Irrigation Manager Software
Manual





Irrigation Manager
Professional Software 

Information management is critical to every business or
profession.  Irrigaiton Manager Software offers professionals
a unique tool to efficiently manage irrigation water usage.

Careful managment of irrigaiton optimizes turf performance
and health.
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1 Introduction

Irrigation Manager™ Software is an advanced software package designed for professional irrigators.  It
allows multiple control and monitoring of irrigation controllers from a central location.  Anything that can
be done with the controllers can be done with the software remotely.

The software features:

· Map View - Enables customized system layout using your own site map
· System View - View of all zone and system settings and configurations
· Reports - Advanced system report capabilities based on logged data
· Zone Graphs - Graph soil moisture, soil temperature, and soil conductivity from logged data
· Water Restrictions - Enables configuration of water restrictions to comply with local ordinances
· Event Pause - Event pause capabilities for weddings, ball games, picnics, etc.
· Manual Programs - Configure custom manual watering sequences for testing, blowouts, etc.

2 Controllers

Acclima Irrigation Manager Software is compatible with two controllers:

Acclima CS3500
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Nelson 8710 EZ Pro Max

3 Connect

Irrigation Manager Software allows your to manage multiple irrigation site from one central location.
The first time you connect with a controller this connection wizard with walk you through the
connection.

Connection to all sites is made available through this view.  Sites may be connected to through either a
modem or an onsite serial connection or viewed offline.  Through the Connect view new sites may be
added and connections edited.

When Acclima Irrigation Manager Software is first opened a connection type is selected.  This type
may be changed at any time.  Choose Connect Through Serial Port  if the connection will be made
through the serial port of your PC or choose Dial-up Through Modem  if dialing from another location
through the modem of your PC (this option requires that the SC3500 is connected a phone line).
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Once you connect to a controller the controller's name appears in the Connect to Controller box.  As
you connect and synchronize to multiple controllers each controller's name will appear in the connect to
controller box.

Connect:

Simply select the controller you wish to connect to and click the connect button.  This will initialize your
computer to dial the controller's modem and synchronize data between the computer and controller
and connect to the controller.  Once connected any changes you make in the software will immediately
be reflected at the controller.  It is as if you are literally at the controller.

View Offline:

You may also view controller's information offline, without connecting to the controller.  Simply select
the controller and click the view offline button.

See Also:
Add a New Connection
Edit a Connection
Delete a Connection

3.1 Add a New Connection

There are two ways to add a new connection between your software and the controller a modem
connection or serial port connection.  Be sure you have your computer connected to the controller
through a serial port for a serial connection.  Likewise be sure the controller is connected to an active
phone line for a modem connection.

Modem Connection

1. Click on the New Connection button.
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2. If you want Acclima Irrigation Manager Software to save and update any information changed while
offline every time you connect to your site, check the Update Controller with Offline Changes
box.

3. Enter the site name.

4. Select a modem from the drop-down list.

5. Enter the telephone number for the controller.

6. Enter user name and password.

7. Click Save if user name and password are desired to be saved, otherwise click Connect .

Serial Port Connection

1. Connect to controller through serial port.

2. Open Acclima Irrigation Software.

3. Click Serial Port .  Connection should be established automatically.

See Also:
Edit a Connection
Delete a Connection

3.2 Edit a Connection

You can edit the connection to a controller to adjust the controller's site name, telephone number, user
name and password.

To edit a connection:

1. Select desired site to edit.
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2. Click the Edit  button.

3. Make desired changes and click Save.

See Also:
Add a New Connection
Delete a Connection

3.3 Delete a Connection

If for some reason you want to delete a connection to a controller do the following:

1. Select desired connection to delete.

2. Click the Delete button.

See Also:
Add a New Connection
Edit a Connection

3.4 Syncronizing Data

Your controller stores information about your system is the form of logs.  These logs include
information gathered from the controller and sensors.  Logs are stored in your controller for up to six
months.  After six months the older logs are replaced by the newer logs.

Each time you connect to a controller using Irrigation Manager Software the controller's data is
synchronized with the software.  Your computer stores the logged information from the controller,
though the controller  will only store six months of data, your computer will maintain a record of all data
it receives from the controller.  It is important to frequently connected to the controllers to keep your
computer up to date with the controllers.
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Changes made from the controller's panel:

When you adjust your system from the control panel the adjustments are recorded in your controller's
memory and will synchronize with the software the next time your connect with the controller.  The
software will reflect the adjustments you have made to the controller.

Changes made in the software while connected:

When you make adjustments to the system from the software while connected to the controller the
changes are instantly reflected at the controller.  It is as if your are at the controller making the
adjustments yourself.

Changes made in the software while off line:

While viewing the system off line through the software you can make adjustments to the system's
configurations.  These changes will be updated in the controller the next time you connec to the panel.

4 System Configureations

The irrigation system must be configured before it can be used.  Configuration involves setting up
devices such as sensors, flow meters, zone adapters and water sources, and assigning these devices
to zones.

In order to properly configure the system first configure the devices, then configure the zones by
assigning the devices to zones.

See Also:
Configure Devices
Configure Zones

4.1 Controller Configureation

Configuring the controller allows you to edit general controller settings.  These include Central
Controller Settings, modem settings, clock, etc...

To configure the controller select Configure>Controller Configurations from the file menu.

See Also:
Operational Settings
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Factory Settings
Controller Time
Central Control Settings
Site Name
Advanced

4.1.1 Operational Settings

Max Zones Watering Simultaneously
This field adjusts the number of zones the CS3500 will allow to water simultaneously 1 through 4.  This
setting is only the maximum number of zones, the actual amount will depend on your zone's individual
flow rates, water management settings, etc.

Valve Delay/Flow Setting

Most systems have a delay between the time the valve opens and the time water begins to flow.  Use
this setting to adjust this valve time delay from 1 to 999 seconds.

Minutes between sensor log readings
This field adjusts the time between log readings from the sensors.  It can be adjusted from 5 to 60
minutes between logs.

4.1.2 Factory Settings

Factory/Calibrations settings are displayed here.

Factory settings should not be modified unless directed by an Acclima technician.
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4.1.3 Controller Time

The functions within the controllers are monitored by an internal clock.  This screen allows for
adjustment of the controller's internal clock as well as synchronization between your computer's clock
and the controller's.

The clock can be set in one of two ways:

1. Synchronized with the computer's clock
2. Set Manually

4.1.4 Central Control Settings

The Central Control Settings window allows you to adjust the central control communications settings
on the controller.  The controller includes a modem and is capable of communicating with computers
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You can create up to 3 login names and passwords.  Be sure to keep a record of the users and
passwords to access the controllers.
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4.1.5 Site Name

This window allows you to enter information about you irrigation site, such as name, address and
phone number.

4.1.6 Advanced

The advanced screen is for factor use only.  You should not make any adjustments to any of the
information on this screen.

These setting should not be modified unless directed by an Acclima technician.
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4.2 Configure Devices

All devices installed on the system are displayed by category.  This includes sensors, zone adapters,
flow meters, pressure meters, and water sources.  Once the device is configured they can be assigned
to a zone.  You may Add or Remove devices from this menu.  You may also view and modify the
configuration of any device by selecting that device.
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See Also:
Install/Remove/Reconfigure System Devices
Water Source
Moisture Sensor
Zone Switch (Adapter, Decoder)
Flow Meter
Pressure Meter

4.2.1 Install/Remove/Reconfigure System Devices

Once a device is physically installed/removed on the irrigation system at your site it must also be
installed/removed on the software.  Be sure not to change configurations on the software without first
making the changes on the site and vise versa.  Devices can also be reconfigured if you have made
errors or wish to change the system configuration.

To install a valve or moisture sensor:

1. Click the Install System Devices  button.
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2. Enter the serial number of the device and click Detect by Serial Number .  Serial numbers are
inscribed on the device.  Zone Adapters contain many serial numbers (see the CS3500 installation
guide for details).

To add a water source:

1. Click Add Water Source .

To remove a system device:

1. Select the device in the Configure Devices  view.

2. Click the Remove System Devices  button.  The system device options are listed and all other
devices that are connected to the device that will be unconfigured.

3. Click Remove Device .

To replace a device:

1. Select the desired device to be removed.

2. Click the Replace Device  button.

3. Enter the serial number of the newly installed device and click Replace .  All configured settings for
the old device will be transferred to the new device.

The Refresh Addresses  button is to be used only if additional devices are added that may have been
used in another system.  The controller will refresh all the device addresses to ensure there are no
conflicting addresses.

See Also:
Water Source
Moisture Sensor
Zone Switch (Adapter, Decoder)
Flow Meter
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Pressure Meter

4.2.2 Moisture Sensor

Acclima TDT Soil Moisture Sensors are the key to maintaining and managing your irrigation system.
The data logs and information they provide will enable you more efficiently maintain your system.  It is
important that sensors be configured properly.  You can control the upper and lower thresholds, take a
sensor reading, and view the current soil moisture settings from the sensor configuration screen.

To configure sensors:

1. Select a moisture sensor to view the device options by double clicking its name.

2. Change the sensor name by entering the Name field and typing a description of the sensor
location.

3. From the drop-down menu select a Host Zone  for the sensor.  The Host Zone is the zone in which
the sensor is physically located.

4. Set the upper and lower thresholds by clicking the up and down arrows of the respective fields or
by grabbing the threshold lines on the graph and moving them up or down with the mouse.

5. Take a current reading from the sensor, click the Read Sensor  button.  This will display the
moisture level, soil temperature and soil conductivity.

See Also:
Install/Remove/Reconfigure System Devices Water Source
Water Source
Zone Switch (Adapter, Decoder)
Flow Meter
Pressure Meter
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4.2.3 Zone Adapter (Switch, Decoder)

Your controller communicates with the solenoid valves throughout your system through zone adapters.
Each solenoid must be routed through a zone adapter or soil moisture sensor in order to function
effectively.  Once the zone adapters are installed they must be configured in the software, named, and
assigned to zones.

To configure zones:

1. In the Configure Zones  view select the zone to rename.

2. Type new zone name in the Zone Name text box.

3. From the Configure Zones  tab select the zone to change/configure type.

4. Select a zone type from the Zones Type drop-down list.  Once the zone type has been selected
options appear according to that selection.

There are three choices for each zone.  A Reference Zone is a zone that is controlled entirely by a
moisture sensor.  Dependent Zones are controlled by a reference zones sensor and may be set to
run as a percentage of the reference zone.  The third zone type is a Timed zone is runs as a
conventional zone by a clock.

Reference Zones display a Moisture Sensor  drop-down list of the available moisture sensors.
Link the zone with its respective sensor.  In very rare occasions where the soil is extremely
hydrophobic a delay time may be set to allow water to settle.  Enter the Sensor Zone
Percolation Time in hours if so desired.  Otherwise leave at "0."  Enter the Maximum Water
Duration time in minutes.  If water on demand is desired set the duration high.  If timed cycles
are desired click Show Thresholds  and set the Upper Threshold high.
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Dependent Zones have the options for a drop-down list for which Reference Zone  to track as
well as a Zone Tracking Ratio .  The drop-down list displays every reference zone available.
Select the Reference Zone that is closest to and has similar soil properties to the Dependent
Zone.  The tracking ratio can be used to adjust watering amounts.  This ratio is the amount of
water this zone will receive compared to the reference zone.  Values from 0% to 254% may be
entered (0% receiving no water and 250% water two and a half times the reference zone).

Timed Zones run like a traditional zone and have options for Time Between Water  and
Watering Duration .  The Time Between Water  is measured in hours and can be set from 0
hours to 1000 hours between water.  The Watering Duration  is measured in minutes and can
be set from .5 minutes to 720 minute durations.

5. Check or uncheck the box titled Use Soak Cycling  depending on preference.

6. Enter times in minutes for both Water-On Duration  and Soak Duration .

7. Select the appropriate choice from each of the drop-down lists.  Watering restriction profiles can be
set from the Configure Zones  view by clicking the Edit  button or from the Water Restrictions
view.

8. The Flow Rate  is measured in gallons per minute and may be set according to each system.  If
the flow rate is not known leave default value.

See Also:
Install/Remove/Reconfigure System Devices Water Source
Water Source
Moisture Sensor
Flow Meter
Pressure Meter

4.2.4 Flow Meter

Flow meters allow the controller to monitor flow rates for zones and the system.  Flow meters enable
the system to maximize efficiency by automatically managing the water usage.  If a flow meter is
installed the Acclima Irrigation software can measure the flow rate at the flow meter.

To configure the flow meter:

1. Change the description of the flow meter by selecting the device under Other Devices , selecting
the Name field and entering the flow meter description.

2. A water source may be selected to be configured to the flow meter.  Select water source from the
drop-down Attached to Water Source  menu.

3. Select the appropriate pipe diameter from the Pipe Diameter/ Flow Meter  drop-down menu.

4. Readings may be taken and displayed by clicking the Flow Reading…  button.

See Also:
Install/Remove/Reconfigure System Devices Water Source
Water Source
Moisture Sensor
Zone Switch (Adapter, Decoder)
Pressure Meter
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4.2.5 Pressure Meter

Pressure meters work in conjunction with flow meters to monitor the water pressure in your system.
They are helpful for diagnosing problems such as broken sprinkler heads, broken pipes and other flow
problems.  You can set warning levels to allow the system to either warn you or shut down if the
pressure gets too high or too low.

To configure pressure meters:

1. Change the description of the pressure meter by selecting the device under Other Devices ,
selecting the Name field and entering the flow meter description.

2. Configure to a water source by selecting the appropriate water source from the Attached to Water
Source  drop-down menu.

3. Select the desired High Pressure Warning Level .

4. Select desired Low Pressure Warning Level .

5. Pressure readings are taken and displayed by clicking the Pressure Reading … button.

See Also:
Install/Remove/Reconfigure System Devices Water Source
Water Source
Moisture Sensor
Zone Switch (Adapter, Decoder)
Flow Meter

4.2.6 Water Source

All systems have a water source.  Irrigation manager defaults to just one constant source.  If your
system only has one water source you may choose to use the default setting.  However, if your system
has multiple water sources, two mains or some other configurations you need to configure each water
source and assign zones to each source.

To configure a water source:

1. Select the water source.

2. In the Name field type the water source description.

3. Enter the minimum and maximum flow rates for the water source.  If values are unknown leave



Irrigation Manager Software Manual20

© 2006 ... Acclima, Inc. 

default factory settings.

4. Enter valve current by clicking the Test  button.

5. Assign zones to water source click the Assigned Zones  button.  Select the water source and the
zones to be assigned to that water source.  Zones not assigned to the selected water source will
appear without highlights, zones assigned to the selected water source will appear with a green
highlight and zones not assigned to any water source will appear in red.

6. Under the Switch Type  select the appropriate type.  If  Pump Switch is selected and the pump
supports a backflush switch check the Supports Backflush  Switch box.

See Also:
Install/Remove/Reconfigure System Devices Water Source
Moisture Sensor
Zone Switch (Adapter, Decoder)
Flow Meter
Pressure Meter

4.3 Configure Zones

All irrigations systems are grouped in zones controlled by a valve.  Irrigation Manager Software allows
you to view and manage all the zones in one easy to use configuration view.  Each zone may be
configured or updated as desired in this view.  Zone types, sensor selection, soak cycling, water source
and water restrictions are all chosen from this view.

See also:
Rename a Zone
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Select a Zone Type
Toggle Soak Cycle
Select a Water Source
Select a Watering Restriction
Select a Flow Rate

4.3.1 Rename a Zone

Zone names are important to easily manage your system.  The names should reflect either the zone's
location, sprinkler type, or both.  At any time you can rename your zones.

To rename a zone:

1. In the Configure Zones  view select the zone to rename.

2. Type new zone name in the Zone Name text box.

See also:
Select a Zone Type
Toggle Soak Cycle
Select a Water Source
Select a Watering Restriction
Select a Flow Rate

4.3.2 Select a Zone Type

There are three choices for each zone.  A Reference Zone is a zone that is controlled entirely by a
moisture sensor.  Dependent Zones are controlled by a reference zones sensor and may be set to run
as a percentage of the reference zone.  The third zone type is a Timed Zone that runs as a
conventional zone by a clock.

1. From the Configure Zones  tab select the zone to change/configure type.

2. Select a zone type from the Zone Type drop-down list.  Once the zone type has been selected
options appear according to that selection.

Reference Zones display a Moisture Sensor  drop-down list of the available moisture sensors.
Link the zone with its respective sensor.  In very rare occasions where the soil is extremely
hydrophobic a delay time may be set to allow water to settle.  Enter the Sensor Zone Percolation
Time in hours if so desired.  Otherwise leave at "0."  Enter the Maximum Water Duration time in
minutes.  If water on demand is desired set the duration high.  If timed cycles are desired click
Show Thresholds  and set the Upper Threshold high.

Dependent Zones have the options for a drop-down list for which Reference Zone  to track as well
as a Zone Tracking Ratio .  The drop-down list displays every reference zone available.  Select
the Reference Zone that is closest to and has similar soil properties to the Dependent Zone.  The
tracking ratio can be used to adjust watering amounts.  This ratio is the amount of water this zone
will receive compared to the reference zone.  Values from 0% to 254% may be entered (0%
receiving no water and 250% water two and a half times the reference zone).
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Timed Zones run like a traditional zone and have options for Time Between Water  and Watering
Duration .  The Time Between Water  is measured in hours and can be set from 0 hours to 1000
hours between water.  The Watering Duration  is measured in minutes and can be set from .5
minutes to 720 minute durations.

See also:
Rename a Zone
Toggle Soak Cycle
Select a Water Source
Select a Watering Restriction
Select a Flow Rate

4.3.3 Soak Cycle

Soak Cycling may be used in all three of the zone types.  Soak Cycling simply waters for a period of
time then waits to soak before continuing to water, all during one watering period.  This is especially
useful when irrigating a zone located on a slope, allowing the water to soak before it runs off.  While a
zone is soaking the system will use the time to water another zone then return to the soaking zone.

To set the soak cycle:

1. Check or uncheck the box titled Use Soak Cycling  depending on preference.

2. Enter times in minutes for both Water-On Duration  and Soak Duration .

See also:
Rename a Zone
Select a Zone Type
Select a Water Source
Select a Watering Restriction
Select a Flow Rate

4.3.4 Select a Water Source

Each zone must be assigned a water source.  If your system has only one source and is using the
default water source the <Unassigned> box will be displayed.

To assign a water source:

1.    Select the zone.

2. Select the appropriate choice from each of the drop-down lists.
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See also:
Water Source
Rename a Zone
Select a Zone Type
Toggle Soak Cycle
Select a Watering Restriction
Select a Flow Rate

4.3.5 Select a Watering Restriction

Each zone can be assigned a watering restriction independently of the other zones in the system.  This
enables each zone to operate independently of the system.  You must first set up your water
restrictions they assign them to zones.

To assign watering restrictions:

1. Select the zone.

2. Select the appropriate choice from each of the drop-down lists.  Watering restriction profiles can be
set from the Configure Zones  view by clicking the Edit  button or from the Water Restrictions
view.

See also:
Water Restrictions
Rename a Zone
Select a Zone Type
Toggle Soak Cycle
Select a Water Source
Select a Flow Rate

4.3.6 Select a Flow Rate

If your system has a flow meter is will automatically assign flow rates to each zone as they water.  If
you are not using flow meters it is not necessary to indicate a flow rate, use the default rate.

To specify flow rates:
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1. Select the zone.

2. The Flow Rate  is measured in gallons per minute and may be set according to each system.  If
the flow rate is not known leave default value.

See also:
Rename a Zone
Select a Zone Type
Toggle Soak Cycle
Select a Water Source
Select a Watering Restriction

4.4 Manual Programs

Irrigation Manager Software allows you to create special programs that can be run manually.  Each
program includes steps that are able to pause the system or water zones for different durations.  You
can create programs to run tests on sprinkler heads (walk around tests), or when you apply fertilizer
you can create a flush program to run all zones for a several minutes.  This is a powerful tool saving
you time and allowing you to run these tests remotely through the software as well as from the
controller.

See Also:
Create and Edit Manual Programs
Insert/Edit Manual Program Steps
Copy/Paste Manual Program Steps
Delete Manual Program Steps
Run/Stop Manual Programs

4.4.1 Create and Edit Manual Programs

You can create manual programs that are customized  for your specific needs.  First you must add a
program to the program list.

To add a program:

1. Create or select a manual program by clicking the Add Program  button or by selecting a program
from the Program  list.
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2. Rename the program by typing name in the Program Name  field.

3. Click the Save to save changes.

See Also:
Insert/Edit Manual Program Steps
Copy/Paste Manual Program Steps
Delete Manual Program Steps
Run/Stop Manual Programs
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4.4.2 Insert/Edit Manual Program Steps

Once the program is named you can insert steps or commands you wish the controller to take.

1. From a selected program click the Insert Step  button to insert a new step.

2. Choose a Step Action  by selecting Pause Watering  or Water Zone .

3. If Water Zone  is selected enter a Water Zone  using the up/down arrows or click the … button to
choose a zone from the configured zone list.

4. Enter a Step Duration  using the up/down arrows.

5. Click Save to save changes.

See Also:
Create and Edit Manual Programs
Copy/Paste Manual Program Steps
Delete Manual Program Steps
Run/Stop Manual Programs
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4.4.3 Copy/Paste Manual Program Steps

To speed up the building of a manual program you can copy/paste steps in order to make minor
adjustments quicker.  You can rapidly fill in the commands then make minor changes like the zone
name and/or durations.

To copy/paste manual program steps:

1. Select a Program Step .

2. Click the Copy Step  button.

3. Select the step before the desired new step location and click the Paste button.

4. Click Save to save changes.

See Also:
Create and Edit Manual Programs
Insert/Edit Manual Program Steps
Delete Manual Program Steps
Run/Stop Manual Programs

4.4.4 Delete Manual Program Steps

To delete a manual program step:

1. Select a Program Step .

2. Click the Delete Step  button.

3. Click Save to save changes.

See Also:
Create and Edit Manual Programs
Insert/Edit Manual Program Steps
Copy/Paste Manual Program Steps
Run/Stop Manual Programs

4.4.5 Run/Stop Manual Programs

You can run the manual programs from the controller panel or remotely from the software.

To run/stop a manual program:

1. Select a Program .

2. Click the Start Program  button to start a manual program.

3. Click Stop Program  to stop manual program.



Irrigation Manager Software Manual28

© 2006 ... Acclima, Inc. 

See Also:
Create and Edit Manual Programs
Insert/Edit Manual Program Steps
Copy/Paste Manual Program Steps
Delete Manual Program Steps

4.5 Event  Pause

The entire system may be paused for scheduled events.  This is particularly helpful for special
occasions such as parties, ball games, picnics etc. where you want the system to pause operations for
a given period of time.  Scheduled event dates, times and durations are set in this view.  Up to 6
events may be scheduled at one time.

See Also:
Create and Edit Scheduled Events
Delete Scheduled Events

4.5.1 Create and Edit Scheduled Events

1. Create a paused event by clicking on a day in the calendar view or by selecting a scheduled event
on the left side of the screen.

2. Select the Water-Off Date  by clicking a date in the Water-Off Event  window.

3. Select a Water-Off Time  by selecting the hour, minute or AM PM and then toggle the time by
clicking the UP or DOWN arrows.
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4. Enter Pause System Water  Duration by clicking the UP and DOWN arrows for Days, Hours  and
Minutes .  The pause and resume dates and times are displayed in orange at the bottom of the
Pause System Watering  screen.

5. Enter an Event Description  to distinguish the event from any other events that may be scheduled.

6. Click Save to save and close Water-Off Event window.

4.5.2 Delete Scheduled Events

1. Select a paused event by clicking on an event in the calendar view or by selecting a scheduled
event on the left side of the screen.

2. Click the Delete button at the bottom of the Water-Off Event  window to delete and close the
Water-Off Event  window.

4.6 Water Restrictions

Sensor controlled zones are programmed to water as needed to keep a healthy lawn.  There are times
when it is best the controller not be able to water, during the hottest hours of the day or when local
watering restriction prohibit watering.  These times are programmed in the Water Restrictions view to
prohibit your system from watering during these inappropriate times.
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Create and Edit Watering Restrictions:

Watering restrictions are divided into profiles called Restriction Names .  These restriction names are
profiles for zones that will be watered similarly.  For example, if every Friday night there is an activity
held in a certain part of the turf I would create a restriction that would not be able to water during that
time and set the zones that cover that area of the turf to that restriction name.  Other restrictions might
be able to water during that period and only zones that would not affect the area would be set to those
restriction names.  The Acclima Irrigation software comes with five preset restriction names that may
be changed to fit the needs of the user.

1. Select a restriction name on the left hand side or create a new restriction by clicking New

2. Select seasonal restriction.  Year-round watering will water with the same restrictions all year.  If
seasonal watering is selected season start and end dates are required.

3. Select a daily restriction  by clicking on the blue underlined everyday .   Daily restrictions may be
set to everyday, even days, odd days, every other day or up to every 10th day.

4. Hourly restrictions  are on the right hand side of the screen.  Hourly restrictions may be set for
half hour intervals each day of the week.  Changes may be made by clicking a half hour block or by
clicking and dragging for a successive set of half hour.

4.7 Export Configurations

Your Irrigation Manager Software configurations and information are vital to efficiently managing your
irrigation systems.  It is important to protect the configurations you have created.  You can save and
export the current controller configurations to your computer or others computers.  This is helpful when
switching between computers and installing or upgrading controllers.

To export your configurations:

Select File>Export Configuration

Specify a location to save the configuration.
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4.8 Import Saved Configurations

You can load a saved controller configurations you have saved.  This is helpful when switching
between computers are installing or upgrading controllers.

To import saved configurations:

Select File>Load Configuration

Specify a location of the saved configuration.

5 View

5.1 Map View

The Acclima Irrigation Software is capable of importing a map of each site to be able to visualize
reference, dependent and timed zones.  This provides you with a clear view of your system and
enables you to visually manage your irrigation.
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You can import any jpeg or bitmap image file onto your software's map view.  The default map is
shown above.
NOTE: Once your replace the default map with your image the default map cannot be recovered.

See Also:
Import a Map
Move Zone Icons on Map Display
Display/Hide the Menu or Navigation Bar

5.1.1 Import a Map

NOTE: Changing the map image deletes the default image making the imported image permanent.

You can move the Map Controls box around the screan by clicking the blue bar and dragging the box.

1. Maximize the drop menu by clicking on the square in the top right hand corner of the Map Controls
window.
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2. Click on the Load Map Image  button.

3. Click the Yes button when asked "Loading a new Map Image will reset the placement of some
Zone Icons.  Do you want to continue?"

4. Find the map image and click Open.

See Also:
Move Zone Icons on Map Display
Display/Hide the Menu or Navigation Bar

5.1.2 Move Zone Icons on the Map Display

To visually recreate your irrigation site with the map view you can drag each of your system's zones
and water source to their appropriate locations on the map.  Irrigation manager uses icons to represent
each zone or water source.  Once the icons are placed they can be locked in place.
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To place icons on your map:

1. Maximize the drop menu by clicking on the squire in the top right hand corner of the Map Controls
window.

2. Uncheck the Lock Zone Icons  box.

3. Moving the mouse pointer over an icon will display the zone's description.  Click and hold on the
desired zone and move to zones location.

4. When all zones have been moved to desired locations recheck Lock Zone Icons  box.

See Also:
Import a Map
Display/Hide the Menu or Navigation Bar

5.1.3 Display/Hide the Menu or Navigation Bar

You can use the map controls to Display/Hide the menue or navigation bar.

1. Maximize the drop menu by clicking on the squire in the top right hand corner of the Map Controls
window.

2. Check or uncheck the Show Menu or Navigation Bar  boxes.

See Also:
Import a Map
Move Zone Icons on Map Display

5.1.4 Zone Information Side Pannel

The map view also enables you to fully manage your system.  The Zone Information Side Panel allows
you to manage all the zones in the map view.  The panel displays the zone's status, name, type,
moisture sensors and water restrictions.  You can test the zone's valve current, read a sensor and
manage the zone from this panel.

To use the map view to manage zones simply double click on the zone's icon on the map view.
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The Zone Information Side Panel will open allowing you to manage the zone's information.  A similar
panel is also used when configuring zones.  You can adjust the zone's configuration in either place the
map view or in the configuring zone view.

See Also:
Configure Zones

5.2 System View

The system may be viewed and monitored from the system view.  This allows the system's activity and
status to be viewed at a quick glance.  The zones may also be managed from this view.
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System View Displays:

· Zone Number
· Zone Name
· Zone Type
· Type Detail
· Status
· Exceptions

Double Click on a zone to select and edit its properties.

See also:
Configure Zone
Rename a Zone
Select a Zone Type
Toggle Soak Cycle
Select a Water Source
Select a Watering Restriction
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Select a Flow Rate

5.3 Reports

Watering information is recorded stored in the controller and transferred to any PC that connects to it.
The information collected from the controller is vital to efficiently management your irrigation system.
This information may be accessed through the reports view.  Total water, water cycles and manual
waterings are available for viewing for each zone on this graph.

View a Report:

To run a report select the Start  and End Date  by clicking on the drop-down menu and selecting the
appropriate date on the calendar.  Click on the Run Program  button to view the report.

The report may be edited by reselecting Start  and End Dates .  The report's colors may be changed by
clicking on the color that is desired to be changed and selecting a new color from the Color  window.
The zoom slider changes zoom of the report.

Moving the mouse icon over a zone or any part of the report displays the description of that item.

5.4 Zone Graphs

Sensor readings are recorded and stored in the controller and are transferred to any PC that connects
to it.  This information may be accessed through the Zone Graphs view.  Zone graphs enable a visual
view of soil moisture readings.  You can see the moisture level increase dramatically when the system
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waters as well as when it rains.  During the day the sun evaporates water from the turf and at night the
evaporation ceases.  This can be viewed by a seeing the moisture level flatten out during the night and
begin to drop during the day.  Study these graphs to be better acquainted with your soil characteristics.
Soil conductivity, soil temperature and soil moisture are displayed for each sensor in this view.

Edit a Graph:

The graph shows the readings for one sensor at a time.  The sensor may be selected by clicking on
the sensor at the bottom of the Zone Graphs  view.

There are two ways to edit the graph view.  Zoom in or out on the data by moving the Zoom  slider
above the graph.  Move the data or dates by either using the scroll bar below the graph or by clicking
anywhere on the graph and moving the mouse.

Soil conductivity and temperature may be viewed by clicking on either the °F  or the dS/m buttons.
These are displayed above the soil moisture on the graph.

To recenter data click the   button.  To display water on times click  and to display

manual waterings click the   button.
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The blue dots on the graph indicate when the controller initiated a watering cycle.

To view details  about the watering cycle place the mouse arrow on the blue dot.

A yellow box appears displaying the start time and duration of the watering cycle.

View Temperature and Soil Conductivity:

Press the   button to view the temperature graph.  Similarly press the  button to view the
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soil conductivity graph.  These two graphs appear above the soil moisture graph.  As you adjust the
soil moisture graph the other temperature and soil conductivity graphs will adjust to match the formate
of the soil moisture graph.

See also:
Sensor Logs

6 Working with Logs (Data)

Irrigation Manager Software uploads data from the controllers to be viewed, reported, and exported
each time it is connected to your controller.  This enables you to see at a glance exactly how your
system is functioning.  Your controller has sufficient memory to archive data logs for six months after
which the oldest data will be overwritten by the new data.  However, once you synchronize the
controller logs with your Irrigation Manager Software the data logs remain permanently on your
computers hard drive.

The CS3500 controller logs data from sensors, flow meters, pressure meters, and other installed
devices.  These logs are viewed by selecting View>Controller Logs  from the file menu.
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Irrigation Manager will display three types of logs:

1. Sensor Logs
2. Error Logs
3. Watering Logs

Click on the tabs at the top of the screen to move between the three log types.

You can select, sort and navigate the logs to better view the data.

Viewing only selected Data:

Select the arrow next to each column heading to open a drop down menu.  Select how you want the
data displayed.  The data logs will only display the data you selected.
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Sorting Data:

To sort data in each column click on the column heading.  The data will now be sorted by that column
heading.

Navigating the data logs:

The navigation bar is located at the bottom of the screan.  Use the arrows to move between the fields.

See Also:
Sensor Logs
Error Logs
Watering Logs
Exporting Data

6.1 Sensor Logs

You controller uses Acclima TDT Soil moisture sensors to monitor soil moisture.  The sensors also
monitor and log soil temperature and soil conductivity.

Soil Moisture:

The sensors record soil moisture based on volumetric water content (VWC).  This number is
represented as a percentages of total water content.  A reading of 25% means that in any given
volume of soil 25% of it is water.

Soil Temperature:

Soil temperature is recorded and stored in the system.  Temperature can be displayed in degrees
Celsius or degrees Fahrenheit.

Soil Conductivity:

The sensor will also log soil conductivity displayed in dS/m.

Sensor Logs
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This screen allows you to view and check sensor logs.
Each time the sensor takes a reading the controller stores and logs these readings.  These logs are
viewable in the sensor log screen.

See Also:
Exporting Data

6.2 Error Logs

When the system encounters an error the information regarding the error is logged and viewalble in the
error logs window.
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See Also:
Exporting Data

6.3 Watering Logs

All watering activity is recorded in the watering logs window.
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See Also:
Zone Graphs
Exporting Data

6.4 Exporting Data

The data your system collects is extremely valuable for managing your system's efficiency.  You may
wish to export the data into other programs allowing greater flexibility and analysis of the data. You can
export all logs into other programs such as Microsoft Excel.

To export data:

Click on the Exporting Button near the top of the screen.
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You can then choose where you want to export the logs.  All logs are exported in Comma Delimited
(*.csv) format.

Click Save to save the file.

See Also:
Sensor Logs
Error Logs
Watering Logs
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